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Learning Objective
Following this tutorial, you will be able to perform group-wise automatic mesh-
based analysis of cortical thickness.
You will learn how to create a CSV file to set the input dataset, run the end-
to-end module GAMBIT to generate cortical thickness measurements and 
display MRML scenes for quality control. 
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Platform

• GAMBIT has been developed and tested on linux.

• GAMBIT will be cross-platform soon and directly available as a 3D 
Slicer extension.

http://na-mic.org/
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Pre-requisite

This tutorial assumes that you have already completed tutorials for first-time 
and beginning users.

Tutorials are available at the following location: 
http://www.slicer.org/slicerWiki/index.php/Slicer_3.6:Training

Tutorials:

• Slicer3 Minute tutorial (Author: Sonia Pujol, Ph.D.)

• Slicer3 Visualization tutorial (Author: Sonia Pujol, Ph.D.)

http://na-mic.org/
http://www.slicer.org/slicerWiki/index.php/Slicer_3.6:Training
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Material

Disclaimer: It is the responsibility of the user of Slicer to comply with both the terms 
of the license and with the applicable laws, regulations, and rules.

This tutorial requires the installation of 3D Slicer, external modules, tutorial 
dataset and related atlas. They are available at the following locations:

• 3D Slicer download page (Slicer 3.6 release)
http://www.slicer.org/pages/Special:SlicerDownloads

• ABC (Atlas Based Classification) available as a 3D Slicer extension

• External modules and tutorial dataset download page 
(GAMBIT_Tutorial_Example_1.0 and GAMBIT_Executables_1.0)

 http://www.nitrc.org/projects/gambit/
• ShapeWorks download page (ShapeWorks-0.3.0)

 https://gforge.sci.utah.edu/gf/project/shapeworks/frs/

• Atlas download page (UNC_Pediatric_Brain_Atlas)
 http://hdl.handle.net/1926/1508

http://na-mic.org/
http://www.slicer.org/pages/Special:SlicerDownloads
http://www.nitrc.org/projects/gambit/
https://gforge.sci.utah.edu/gf/project/shapeworks/frs/
http://hdl.handle.net/1926/1508
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Material: Tutorial dataset

• Download and unzip “GAMBIT_Tutorial_example_1.0.zip” from the 
following download page:

http://www.nitrc.org/frs/?group_id=384

• A “GAMBIT_Tutorial_example_1.0” folder will be created, containing:

• 5 pediatric cases: T1-weighted images.

• A “GAMBIT-Results/” directory, in which results of the tutorial 
example will be saved.

http://na-mic.org/
http://www.nitrc.org/frs/?group_id=384
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Disclaimer: It is the responsibility of the user of Slicer to comply with both the terms 
of the license and with the applicable laws, regulations, and rules.

• ABC is a 3D Slicer external module available directly as an extension

- Open 3D Slicer

- Go to View → Extension Manager 

- Click next on the new window to search for available extensions

- Select ABC and Click “Download and Install”

- Click “Next”

- Choose to “Restart 3D Slicer now”
 ABC will then appear as a 3D Slicer module

Material: External modules

http://na-mic.org/
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Material: External modules

• Download and unzip “GAMBIT_Executables_1.0_linux64.zip” from the 
following download page:

http://www.nitrc.org/frs/?group_id=384

• A “GAMBIT_Executables_1.0” folder will be created, containing executables 
needed to perform cortical thickness analysis.

• Download and unzip “ShapeWorks-0.3.0.zip” from the following page:

https://gforge.sci.utah.edu/gf/project/shapeworks/frs/

– ShapeWorks needs to be compiled locally

– Several executables will be created

– The executable “ShapeWorksRun” needs to be copied to the 
“GAMBIT_Executables_1.0” folder

Note: ShapeWorks will be soon directly available as an executable on several platforms 
as well as a 3D Slicer extension

http://na-mic.org/
http://www.nitrc.org/frs/?group_id=384
https://gforge.sci.utah.edu/gf/project/shapeworks/frs/
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Material: Add External modules

• To add the executables as 3D Slicer external modules:

- Open 3D Slicer

- Go to View → Application Settings →Module Settings 

- Click on the “add a preset” button

- Select the “GAMBIT_Executables_1.0”  folder and confirm

- Close and restart 3D Slicer
 Several modules should appear within 3D Slicer

http://na-mic.org/
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Material: Atlas
• Create a “pediatric-atlas-4years-sym-T1-RAI” folder somewhere in your 
system. 

• Download the “UNC_Pediatric_Brain_Atlas” from the following page:

http://hdl.handle.net/1926/1508

– Download everything:

• Horizontal menu: item -> Download item (.zip)

• Unzip the ZIP file in this new folder.

– OR Download only needed files in this new folder: 

 1.mha, 2.mha, 3.mha, 4.mha, AbsoluteWMMaskImage.nrrd, 
latVentricleMask.nrrd, Parcellation_98Lobes.nrrd, Parcellation.nrrd, 
RemoveGMMaskImage.nrrd, template.mha, template-stripped.nrrd, 

The “pediatric-atlas-4years-sym-T1-RAI” folder will thus contain the atlas 
and its related files.

http://na-mic.org/
http://hdl.handle.net/1926/1508
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Pre-requisites
• Add the executables in the PATH: 
-tcsh usage : setenv PATH GAMBIT-Executables-Directory:Slicer3-Plugins-Directory:Slicer3-Bin-Directory:${PATH}
-bash usage : export PATH=GAMBIT-Executables-Directory:Slicer3-Plugins-Directory:Slicer3-Bin-Directory:$
{PATH} 

Notice : To execute GAMBIT within 3D Slicer, it is not necessary to add "Slicer3-Plugins-
Directory" and "Slicer3-Bin-Directory" in the PATH. 

• Set GAMBIT environment variable 

-tcsh usage : setenv BatchmakeWrapper_Dir GAMBIT-Executables-Directory
-bash usage : export BatchmakeWrapper_Dir=GAMBIT-Executables-Directory

WITH:
• GAMBIT-Executables-Directory/ : Downloaded folder (GAMBIT_Executables_1.2)
• Slicer3-Plugins-Directory/ : Directory containing Slicer3 plugins

•Slicer 3.6 release : “Slicer3Dir”/lib/Slicer3/Plugins
• Slicer3-Bin-Directory/ : Directory containing Slicer3 binary files

 Slicer 3.6 release : “Slicer3Dir”/lib/Slicer3/bin

http://na-mic.org/
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Pre-requisites
Set Slicer libraries variable (ONLY FOR COMMAND LINE)

-tcsh usage : setenv SLICERLIBPATH “Slicer3Dir”/lib 
                       setenv LD_LIBRARY_PATH ${LD_LIBRARY_PATH}:${SLICERLIBPATH}/BatchMake:$
{SLICERLIBPATH}/bmModuleDescriptionParser:${SLICERLIBPATH}/FreeSurfer:${SLICERLIBPATH}/GenerateCLP:$
{SLICERLIBPATH}/GenerateLM:${SLICERLIBPATH}/IGT:${SLICERLIBPATH}/InsightToolkit:$
{SLICERLIBPATH}/ITKCommandIO:${SLICERLIBPATH}/KWWidgets:${SLICERLIBPATH}/LoadableModule:$
{SLICERLIBPATH}/MGHImageIO:${SLICERLIBPATH}/ModuleDescriptionParser:${SLICERLIBPATH}/MRML:$
{SLICERLIBPATH}/MRMLCLI:${SLICERLIBPATH}/MRMLIDImageIO:${SLICERLIBPATH}/OpenIGTLink:$
{SLICERLIBPATH}/Python/lib:${SLICERLIBPATH}/RemoteIO:${SLICERLIBPATH}/Slicer3:$
{SLICERLIBPATH}/SlicerIO:${SLICERLIBPATH}/tclap:${SLICERLIBPATH}/TclTk/lib:${SLICERLIBPATH}/Teem-
1.11.0:${SLICERLIBPATH}/vtk-5.6:${SLICERLIBPATH}/vtkITK:${SLICERLIBPATH}/vtkTeem 

-bash usage : export SLICERLIBPATH=“Slicer3Dir”/lib 
             export LD_LIBRARY_PATH=${LD_LIBRARY_PATH}:${SLICERLIBPATH}/BatchMake:$

{SLICERLIBPATH}/bmModuleDescriptionParser:${SLICERLIBPATH}/FreeSurfer:${SLICERLIBPATH}/GenerateCLP:$
{SLICERLIBPATH}/GenerateLM:${SLICERLIBPATH}/IGT:${SLICERLIBPATH}/InsightToolkit:$
{SLICERLIBPATH}/ITKCommandIO:${SLICERLIBPATH}/KWWidgets:${SLICERLIBPATH}/LoadableModule:$
{SLICERLIBPATH}/MGHImageIO:${SLICERLIBPATH}/ModuleDescriptionParser:${SLICERLIBPATH}/MRML:$
{SLICERLIBPATH}/MRMLCLI:${SLICERLIBPATH}/MRMLIDImageIO:${SLICERLIBPATH}/OpenIGTLink:$
{SLICERLIBPATH}/Python/lib:${SLICERLIBPATH}/RemoteIO:${SLICERLIBPATH}/Slicer3:$
{SLICERLIBPATH}/SlicerIO:${SLICERLIBPATH}/tclap:${SLICERLIBPATH}/TclTk/lib:${SLICERLIBPATH}/Teem-
1.11.0:${SLICERLIBPATH}/vtk-5.6:${SLICERLIBPATH}/vtkITK:${SLICERLIBPATH}/vtkTeem 

WITH: “Slicer3Dir” : path of Slicer 3.6 release in your computer

http://na-mic.org/


National Alliance for Medical Image Computing 
http://na-mic.org  © 2010, ARR

Overview

1- Input file and atlas images

2- Pipeline description

3- Output images and organization

4- Execution within Slicer

5- Example with tutorial dataset

6- Command line execution

http://na-mic.org/
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Input dataset CSV file

• As GAMBIT performs group analysis, an input dataset needs to be set. 
Instead of loading input images one by one, the current solution include 
the use of a CSV file (file with comma separated values), created prior to 
the use of the software.
• Example of such input CSV file:

CaseId,Age,InputImage1,InputImage2, ...
Subject1,2,Subject1_T1.nrrd, Subject1_T2.nrrd, ...
Subject2,4,Subject2_T1.nrrd, Subject2_T2.nrrd, ...
Subject3,2,Subject3_T1.nrrd, Subject3_T2.nrrd, …
...

• Note: In the future, the use of such CSV files will be replaced by the use 
of a 3D Slicer widget, allowing data selection, either locally or via XNAT 
(images with meta data used for statistical analysis)

http://na-mic.org/
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Input segmentation atlas 

• Atlas used for tissue segmentation:
– T1-weighted atlas image
– Atlas class priors: white matter, grey matter, CSF, rest probability 

maps

T1w atlas White matter 
probability map

Grey matter 
probability map

CSF
 probability map

http://na-mic.org/
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Input ROI atlas
 T1w skull-stripped ROI atlas with its label images used to create white 
matter map:
• Absolute white matter mask image: binary mask considered as absolute 
white matter (default: caudate, pallidus, putamen)
• CSF to white matter mask image: large binary mask which will be 
combined with CSF tissue map to segment lateral ventricles
• Remove GM mask image: binary mask which will be removed from white 
matter map (default: amygdala, hippocampus, brainstem, cerebellum)
• Label image for particle initialization: label map image used to initialize 
particle for correspondence step. One particle will be created per label
• Optional: lobar parcellation image

T1w ROI atlas Absolute WM mask Particle initialization label map

http://na-mic.org/
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Pipeline description

Note: Statistical analysis is not performed by GAMBIT. Several 3D Slicer 
modules can be used in that regard, e.g shapeAnalysisMancova (UNC 3D 
Slicer external module)

Individual pre-processing pipeline:
  - Cortical Thickness computation

- WM map inflated cortical surface creation

Group-wise particle-based shape correspondence 
on inflated surfaces

Group-wise statistical analysis

Individual post-processing pipeline:
- Re-meshing 

- Cortical thickness interpolation

http://na-mic.org/
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Input image

ROI segmentation

Individual pipeline description

GenusZero WM cortical image and surface creation

Genus Zero WM cortical surface inflation

Particles initialization

Cortical thickness computation

Tissue segmentation & skull-stripping

WM cortical image creation

Sulcal depth computation

WM Image 
fixing

http://na-mic.org/
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Individual pipeline

Tissue segmentation (ABC, 3D Slicer module)

Probabilistic atlas-based automatic tissue segmentation via an Expectation-
Maximization scheme. ABC also performs an intensity inhomogeneity 
correction of the input image that removes gradual variations in the image 
intensities mainly due to RF coil imperfection

 

T1w image Corrected image Label image

http://na-mic.org/
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Individual pipeline

Skull-stripping (ImageMath, UNC 3D Slicer external module)

Skull-stripping is performed using the previously computed tissue 
segmentation label map. 

 

Corrected image Stripped image

http://na-mic.org/
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Individual pipeline

Deformable registration of T1-weighted atlas
 (RegisterImages, 3D Slicer module)

B-Spline based registration from atlas to skull-stripped T1-weighted image, 
whose ITK transformation is used in the following step to apply 
transformation to related images

 

    Stripped image     T1w atlas

http://na-mic.org/
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Applying deformation to the atlas label images
 (ResampleScalar/Vector/DWI, 3D Slicer module)

Previously computed atlas-to-subject transformation are applied to:
- Absolute white matter mask image - CSF to white matter mask image
- Remove grey matter mask image - Particle initialization label image
- Lobar parcellation image

 

Individual pipeline

Parcellation image Absolute WM mask image

http://na-mic.org/


National Alliance for Medical Image Computing 
http://na-mic.org  © 2010, ARR

Individual pipeline
• White matter map image creation (ImageMath, UNC external module)
WM from tissue segmentation is combined with:

•- Absolute WM mask image (caudate, pallidus, putamen)
•- Lateral ventricles segmentation (obtained from CSF tissue 
segmentation combined with 'CSF to white matter mask image')
•- GM mask image is then substracted to the resulted WM map image

• White matter map image post-processing
(WMSegPostProcess, UNC 3D Slicer external module)

•Filling, connectivity enforcement, smoothing...

WM map image WM map surface

http://na-mic.org/
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Individual pipeline
• Genus-zero WM map image and surface creation
 (GenusZeroImageFilter, UNC external module)
• WM map surface inflation (MeshInflation, UNC external module)
Iterative smoothing using relaxation operator (considering average vertex) and 
L2 norm of the mean curvature as a stopping criterion
• WM map image fixing if necessary (Fix Image, UNC  external module)
White matter map correction with connectivity enforcement for bad vertices 
(really high curvature, due to tissue segmentation)
• Back to genus-zero surface creation step if necessary

GenusZero surface Inflated surface

http://na-mic.org/
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Individual pipeline

• Cortical thickness computation (CortThick, UNC external module)
Voxel-based cortical thickness computation using tissue segmentation 

label map
• Optional: cortical thickness interpolation on genus-zero white matter map 
surface

Cortical thickness on 
genus-zero surface

Cortical thickness on 
inflated genus-zero 

surface

http://na-mic.org/
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Individual pipeline

 Sulcal depth computation (MeshMath, 3D Slicer external module)
•Sulcal depth computation considering genus-zero white matter map 
surface and inflated surface 

Sucal depth on genus-
zero surface

Sucal depth on inflated 
genus-zero surface

http://na-mic.org/
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Individual pipeline

 Particle initialization (ParticleInitializer, MeshMath, external modules)
Initialization of particles on inflated white matter map surface, by 

interpolating label map for particle initialization. One centered particle is 
created per lobe.

Particle initialization map 
on inflated surface

Initialization particles 
on inflated surface

http://na-mic.org/
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Pipeline description

Note: Statistical analysis is not performed by GAMBIT. Several 3D Slicer 
modules can be used in that regard, e.g shapeAnalysisMancova (UNC 3D 
Slicer external module)

Individual pre-processing pipeline:
  - Cortical Thickness computation

- WM map inflated cortical surface creation

Group-wise particle-based shape 
correspondence on inflated surfaces

Group-wise statistical analysis

Individual post-processing pipeline:
- Re-meshing 

- Cortical thickness interpolation

http://na-mic.org/
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Pipeline: Group-wise correspondence

• Particle correspondence pre-processing  
(ParticleCorrespondencePreprocessing, UNC 3D Slicer external module)

Smoothed white matter map distance maps (volumes) creation used as 
input for shape correspondence

• Group-wise particle-based shape correspondence 
(ShapeWorks, Utah 3D Slicer external module)

Correspondence on inflated surfaces using dynamic particle system
Energy minimization by gradient descent of function balancing negative 

entropy of the distribution of particles on each cortical surface with positive 
entropy of the distribution of the shape samples shape space

Documentation available online (ShapeWorksManual.pdf)
https://gforge.sci.utah.edu/gf/project/shapeworks/frs/

http://na-mic.org/
https://gforge.sci.utah.edu/gf/project/shapeworks/frs/
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Pipeline: post-processing

• Particle correspondence post-processing 
(ParticleCorrespondencePostprocessing, UNC 3D Slicer external module)

•White matter inflated surfaces re-meshing using template mesh
•Interpolation by Thin Plate Spline using corresponding particles as 
control-points. Interpolated surfaces are projected to original surfaces

• Surface measurements interpolation
 (MeshMath, UNC 3D Slicer external module)

•Surface measurements (cortical thickness, sulcal depth) are 
interpolated on final white matter cortical surfaces

http://na-mic.org/
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Output organization

  
CorticalThickness/

  InputDir/

  GAMBIT/
  GenusZero/

  MeshAttribute/

  MeshInflation/

*AvgCortThickOnGMBoundary.nrrd
*AvgCortThickOnWMBoundary.nrrd
*labels_EMS-WhiteMatDistanceMap_par_array.csv
*labels_EMS-WhiteMatDistanceMap_par.csv

*corrected_EMS_stripped_WMMap_post_genus.nrrd
*corrected_EMS_stripped_WMMap_post_genus.vtk

*corrected_EMS_stripped_WMMap_post_genus_CortThick.txt
*corrected_EMS_stripped_WMMap_post_genus_infl_InitParticles.lpts 
*corrected_EMS_stripped_WMMap_post_genus_InitParticles.lpts
*corrected_EMS_stripped_WMMap_post_genus_InitParticles.txt
*corrected_EMS_stripped_WMMap_post_genus_Parcellation.txt
*corrected_EMS_stripped_WMMap_post_genus_SulcalDepth.txt

*T1_corrected_EMS_stripped_WMMap_post_genus_infl_curv.txt
*T1_corrected_EMS_stripped_WMMap_post_genus_infl_It2.vtk
*T1_corrected_EMS_stripped_WMMap_post_genus_infl.log
*T1_corrected_EMS_stripped_WMMap_post_genus_infl.vtk

InputFile.csv
InputImages

  ...

http://na-mic.org/
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Output organization

  ROISegmentation/

  TissueSegmentation/

  WMCorticalImage/

  InputDir/

  GAMBIT/

... *corrected_EMS_stripped--lateralVentricles.nrrd
*corrected_EMS_stripped.nrrd
AbsoluteWMMaskImageRegistered*corrected_EMS_stripped.nrrd
AtlasRegistered*corrected_EMS_stripped.nrrd
AtlasTransform*corrected_EMS_stripped.nrrd
CSFToWMMaskImageRegistered*corrected_EMS_stripped.nrrd
ParcellationRegistered*corrected_EMS_stripped.nrrd
ParticleInitializationRegistered*corrected_EMS_stripped.nrrd
RemoveGMMaskImageRegistered*corrected_EMS_stripped.nrrd

*corrected_EMS.nrrd
*labels_EMS_CSF.nrrd
*labels_EMS.nrrd
*labels_EMS_WM.nrrd

*corrected_EMS_stripped_WMMap.nrrd
*corrected_EMS_stripped_WMMap_post_init.nrrd
*corrected_EMS_stripped_WMMap_post.nrrd

http://na-mic.org/
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Output organization

  OutputDir/
GAMBIT_Computation.bms
GAMBIT_Parameters.bms
GAMBIT_MRMLCreation.bms

  Correspondence/
GAMBIT_CorrespondencePreprocessing.params
GAMBIT_Correspondence.params
GAMBIT_CorrespondencePostProcessing.params

  Correspondence/

  CorrespondencePostProcessing/

  CorrespondencePreProcessing/ *_WMMap_infl_DistanceMap.mha

*_WMMap_infl_particles.lpts

*_WMMap_infl.vtk
*_WMMap_infl_SulcalDepth.txt
*_WMMap_infl_CortThick.txt

  MRML/
SlicerScene_CorrespondingMesh.mrml
SlicerScene_SmoothedGenusZeromesh.mrml
SlicerScene_InflatedMesh.mrml

http://na-mic.org/
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Execution within Slicer

4.1- Default execution

4.2- Advanced parameters

http://na-mic.org/
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Default execution

1. Select “GAMBIT” module (in All modules)

2. Set new parameter set

3. Set dataset input CSV file

4. Set output directory

5. Set tissue segmentation atlas directory and atlas 
type

6. Set ROI atlas image and its label images

7. Click on the “Apply” button to process the dataset 

1

2

3
4

5

6

7

http://na-mic.org/
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Execution within Slicer

4.1- Default execution

4.2- Advanced parameters

http://na-mic.org/
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Advanced input file parameters
1. Manual input column selection: check if dataset should be found manually 
using parameter 2

2. Set column number of T1w input image for manual selection (parameter 1 
must be set)

3. Check to include T2w images (useful for tissue segmentation) in the dataset

4. Set column number of T2w input images for manual selection (parameter 3 
must be set)

5. Check to include PDw images (useful for tissue segmentation) in the dataset

6. Set column number of PDw input images for manual selection (parameter 3 
must be set)

1
2
3
4
5
6

http://na-mic.org/
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Advanced tissue segmentation parameters

1. Set maximum bias degree parameter

2. Set atlas class prior weights (for WM,GM,CSF,rest)

3. Set number of iterations for atlas-to case warping (fluid deformation)

4. Set type of linear mapping (prior to warping)

5. If several input images, set linear mapping type (second image registered to 
first one)

1
2
3
4
5

http://na-mic.org/
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Advanced skull-stripping and atlas 
registration parameters

1. Check/unchek to dilate tissue segmentation label map used for skull-
stripping, useful is the segmentation is not perfect.

2. Set initialization for atlas to subject B-Spline pipeline-based registration 
(default: center of mass)

1

2

http://na-mic.org/
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Advanced inflation 
parameters

1. Set number of iterations until inflation is stopped, if necessary, to fix the 
cortical surface

2. Set maximum curvature to save only vertices whose curvature is higher than 
max curvature once inflation is stopped after parameter 1

3. Set maximum number of iterations during inflation

4. Set minimum mean surface curvature used a a stopping criterion to stop 
inflation. Curvature keeps decreasing until minimum mean curvature is reached.

5. Set surface inflation relaxation operator (0=no smoothing, 1=full smoothing)
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Advanced correspondence parameters

1. Set gaussian smoothing for preprocessing

2. Set number of particles to sample surfaces

3. Set number of iterations to run between successive 
particle splits during an initialization phase until number of 
particles (param 2) is reached

4. The starting regularization (added to the covariance 
matrix of the correspondences) decays to the ending 
regularization over the specified number of optimization 
iterations

5. Set number of iterations between successive save of the 
optimized correspondence positions

6. Weighting factor balancing a tradeoff between 
compactness and accurate shape representation

7. Set procrustes registration performed based on the 
current correspondence positions at each specified interval, 
with scaling is analysis is done independently of shape

8. Set weighted projection of the interpolated surface to the 
original surface during correspondence post-processing (re-
meshing)
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Overview

1- Input file and atlas images

2- Pipeline overview

3- Output images and organization

4- Execution within Slicer

5- Example with tutorial dataset

6- Command line execution

http://na-mic.org/


National Alliance for Medical Image Computing 
http://na-mic.org  © 2010, ARR

Example with tutorial dataset

5.1- Create input CSV file

5.2- Load input atlas images

5.3- Run GAMBIT
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Create input CSV file

• In the “GAMBIT_Tutorial_example_1.0” folder create a CSV file 
“GAMBIT_InputFile.csv” containing input images separated by commas:

CaseId,Age,InputFile1

Subject1,2,”InputDir”/Subject1_T1.nrrd

Subject2,2,”InputDir”/Subject2_T1.nrrd

Subject3,2,”InputDir”/Subject3_T1.nrrd

Subject4,2,”InputDir”/Subject4_T1.nrrd

Subject5,2,”InputDir”/Subject5_T1.nrrd

With “InputDir”: full path on your system of the 
“GAMBIT_Tutorial_example_1.0” directory
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Example with tutorial dataset
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Load input atlas images

In 3d Slicer, select the 
module « Volumes » to load 
the input atlas images.

Then click on the « Select 
Volume File » button to load 
the images.
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Load input atlas images

A window ‘Open Volume File’ pops up. Select the «pediatric-atlas-
4year-sym-T1-RAI» directory, then select the « template-
stripped.nrrd » file and click « Open ».
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Load input atlas images

Now, select the Image Origin 
as « Centered ».

And click on « Apply ».

The atlas is now loaded.
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Load input atlas images

Repeat the same process to 
load the atlas label images:
 - AbsoluteWMMaskImage.nrrd
 - latVentricleMask.nrrd
 - Parcellation_98Lobes.nrrd
 - Parcellation.nrrd
 - RemoveGMMaskImage.nrrd

 However you need to check 
the « Label map » button to 
display them properly.
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Module execution

1- Select « GAMBIT » module 
(in All Modules)

2- Set a new parameter set

3- Click on the « input group 
file » button. A new window will 
pop up.
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Module execution

A new window ‘Select File’ pops up. Select the 
«GAMBIT_Tutorial_example_1.0» directory, then select the 
« GAMBIT_InputFile.csv » file and click « Open ».
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Module execution

Click on the « output 
directory » button. A new 
window will pop up.
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Module execution

Select  the « GAMBIT-Results » 
directory, located in the 
“GAMBIT_Tutorial_example_1.0” 
directory
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Module execution

Click on the « segmentation 
atlas directory » button. A 
new window will pop up.
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Module execution

A new window ‘Select Directory’ pops up. Select the « pediatric-atlas-
sym-T1-RAI » directory and click « Ok ».
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1- Set the « input atlas images ».
T1w ROI atlas image 

-> template-stripped.nrrd
Atlas absolute WM mask image 

-> AbsoluteWMMaskImage.nrrd
Atlas CSF to WM mask image 

-> latVentricleMask.nrrd
Atlas remove GM mask image 

-> RemoveGMMaskImage.nrrd
Atlas label image for particle initialization 

-> Parcellation_98Lobes.nrrd
Atlas parcellation image 

-> Parcellation.nrrd

2- Click « Apply » to process the 
dataset.

Module execution

http://na-mic.org/
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Module execution: QC

• It may take up to one day to process the tutorial dataset.

• 3D Slicer MRML scenes are created at the end of the pipeline:

– SlicerScene_SmoothedGenusZeroMesh.mrml

– SlicerScene_InflatedMesh.mrml

– SlicerScene_CorrespondingMesh.mrml

• Once the dataset has been processed, one can load these scenes one 
by one for an efficient quality control:

– File -> Load Scene

– Select “GAMBIT_Tutorial_example_1.0/GAMBIT-Results/MRML” directory

– Click “Open”
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Module execution: QC

Example: SlicerScene_CorrespondingMesh.mrml 

Example: SlicerScene_SmoothedGenusZeroMesh.mrml 
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Module execution: QC
● Each MRML scene contains 3 snapshots allowing color map display 

● To display the color maps:

1. Click on the ”Snapshots” button.

2. Select 'SulcalDepth' or 'CorticalThickness'.

3. Click on 'Restore'.
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Module execution: QC
Example: SlicerScene_CorrespondingMesh.mrml 

Snapshot 2: Sulcal depth overlayed on inflated cortical surfaces

Snaphot 1: Inflated white matter cortical surfaces

Snapshot 3: Cortical thickness overlayed on inflated cortical surfaces

http://na-mic.org/


National Alliance for Medical Image Computing 
http://na-mic.org  © 2010, ARR

Overview

1- Input file and atlas images

2- Pipeline overview

3- Output images and organization

4- Execution within Slicer

5- Example with tutorial dataset

6- Command line execution

http://na-mic.org/


National Alliance for Medical Image Computing 
http://na-mic.org  © 2010, ARR

Command line execution

Default analysis: 

GAMBIT GAMBIT_InputFile.csv TestGAMBIT

--segAtlasDir segAtlas 

--ROIAtlas ROIAtlas/template-stripped.nrrd 

--atlasParcellationImage ROIAtlas/Parcellation.nrrd 

--atlasParticleInitializationImage ROIAtlas/Parcellation_98Lobes.nrrd 

--atlasAbsoluteWMMaskImage ROIAtlas/AbsoluteWMMaskImage.nrrd 

--atlasCSFToWMMaskImage ROIAtlas/latVentricleMask.nrrd 

--atlasRemoveGMMaskImage ROIAtlas/RemoveGMMaskImage.nrrd 
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Command line execution

Complementary flags:
• Input selection parameters: 

--inputColumnSelection : set manual input colum selection

--inputColumnNumberT1 T1ColumnNumber : set T1 column number

--inputT2Image : Enable/disable use of T2-weighted images

--inputColumnNumberT2 T2ColumnNumber : Set T2 column number

--inputPDImage : Enable/disable use of PD-weighted images

--inputColumnNumberPD PDColumnNumber : Set PD column number

http://na-mic.org/
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Command line execution

Complementary flags:
• Tissue segmentation parameters: 

--ABCMaxBiasDegree MaxBiasDegree : set maximum bias degree

--ABCPriors WMPrior,GMPrior,CSFPrior,RestPrior : set atlas class priors

        --ABCAtlasWarpIterations WarpIterations : set number of fluid iterations

--ABCAtlasLinearMapType AtlasMapType : set atlas linear mapping type

--ABCImageLinearMapType ImageMapType : set image linear mapping type

• Skull-stripping parameters:
--maskDilation : tissue segmentation label map dilation

• Registration parameters: 
--registrationInit Init : Atlas registration initialization method 

http://na-mic.org/
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Command line execution
Complementary flags:
• Inflation parameters: 

--inflationMaxiterationsBeforeFixing MaxFixingIterations : set maximum 
number of iterations until cortical surface is fixed if necessary

--inflationMaxCurvature MaxCurvature : set maximum curvature to save only 
vertices whose curvature is higher than max curvature once inflation is stopped

        --inflationMaxIteration MaxIteration : set maximum number of iterations

--inflationMeanCurvature MeanCurvature : set minimum mean surface 
curvature used as a stopping criterion to stop inflation. Curvature keeps decreasing 
until this minimum mean curvature is reached.

--inflationSmoothing InflationSmoothing : set  relaxation operator (0=no 
smoothing, 1=full smoothing)
• Skull-stripping parameters:

--maskDilation : tissue segmentation label map dilation
• Registration parameters: 

--registrationInit Init : Atlas registration initialization method 
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Command line execution
Complementary flags:
• Correspondence parameters: 

--correspondencePreprocessingSmoothing Smoothing : set gaussian smoothing element size

--correspondenceNbParticles Nbparticles : set number of particles to sample shape

        --correspondenceIterationsPerSplit SplitIterations : set number of iterations to run between 
successive particle splits during an initialization phase

--correspondenceStartingRegularization StartRegularization --correspondenceEndingRegularization 
EndRegularization --correspondenceOptimizationIterations OptimizationIt : The starting regularization 
(added to the covariance matrix of the correspondences) decays to the ending regularization over the 
specified number of iterations

--correspondenceCheckPointingIntervals Interval : set number of iterations between successive 
saves of the optimized correspondence positions

--correspondenceRelativeWeightin Alpha : set weighting factor balancing a tradeoff between model 
compactness and accurate shape representation

--correspondenceProcrustesOff : enable/disable Procrustes registration

--correspondenceProcrustesInterval EndRegularization : procrustes registration is performed based 
on the current correspondence positions at each specified interval
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Command line execution
Complementary flags:
• Correspondence post-processing parameters: 

--correspondencePostProcessingProjectToSurfaceOff : enable/disable projection of 
the interpolated surface to the original

     surface

--correspondencePostProcessingProjectionFactor Factor : Projection factor (0=no 
projection, 1=full projection with possibly collapsed triangles)
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Future improvement

The development of the presented software is an ongoing process, 
further improvements including:

• Quality control improvement with new MRML scenes and snapshots

• Use of 3D Slicer widget to set input dataset

• Consider sulcal depth as attribute to improve correspondence

• Use of average inflated white matter map cortical surface as an 
unbiased template for shape-based correspondence

• Allow correspondence on new dataset by fixing particles on already 
existing sample dataset

• New options/methods thanks to user feedback...
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Conclusion

3D Slicer, is a free, open source software package for visualization and 
image analysis, in this case, Group-wise mesh-based analysis of cortical 
thickness using GAMBIT.  

Thanks to this tutorial you are now ready to perform local cortical 
thickness analysis on your own dataset.
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